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      Excel is great. I use it both in my professional life and my personal life. It allows me to organize and track key information in a quick and easy manner and to automate a lot of the calculations I need.

      I have a budget worksheet that I look at at least every few days to track whether my bills have been paid and how much I need to keep in my bank account and just where I am overall financially.

      (Which I shared in Excel for Budgeting and which you can also purchase a blank version of via my Payhip store if you’re interested. Links available at https://mlhumphrey.com/business-and-personal-finance/)

      In my professional career I’ve used Excel in a number of ways, from analyzing a series of financial transactions to see if a customer was overcharged to performing a comparison of regulatory requirements across multiple jurisdictions.

      It’s also the quickest and easiest way I’ve ever found to take rows of raw data and create summaries of that data.

      While Excel works best for storing numbers and performing calculations, it is also often a good choice for text-based analysis, especially if you want to be able to sort your text results or filter out and isolate certain entries.

      Excel also has very widespread usage. Every single corporate environment I ever worked in used Microsoft Office. I was in banking, finance, and consulting and all of those fields tend to default to Microsoft Office products.

      More creative fields tend more towards Apple products, but your bread and butter corporations are very much still users of Office. So learning Excel (and Word and PowerPoint) is an essential skill if you want to be employed in those types of companies.

      At least for the foreseeable future. Big companies do not like change.

      And honestly, the skills you learn using Microsoft Excel can be applied to similar programs. I use Numbers on my Mac when I need to open a spreadsheet and other than remembering to do Command instead of Control for my shortcuts they work much the same way.

      So Excel is definitely worth learning. It will help you with your own life and your career.

      Now, real quick, I want to discuss the three main versions of Microsoft Office so you understand where this book fits.

    

  


  
    
      
        
          
          

          
            DISCUSSION OF DIFFERENT OFFICE VERSIONS

          

        

      

    

    
      At this present moment (December 2022), Microsoft Office offers essentially three products that all share the same core functionality.

      There is a free version of Microsoft Office that is available online. You can get access to Word, Excel, PowerPoint, and a number of other Microsoft tools by signing up for a free Microsoft account.

      We’ll call this one Office on the Web.

      It has basic functionality that will work for most users, I suspect. But it’s also all online. If you have a file on your computer and want to work with it in the free version you have to upload it and store it in a OneDrive account. It also has limited functionality, so it’s not going to give you the full range of options as the paid products that Microsoft offers.

      Second, are the old-school versions. That’s what I have spent the last thirty years or so using. These are static versions of Office that are locked into place at a point in time.

      As I write this, the latest static, or as Microsoft likes to call them, “on premise”, version of Microsoft Office is Office 2021. The original Office Essentials books I wrote used Office 2013 and I also published a series of titles on Office 2019, but there have been many other versions of Office over the years.

      Each of the static versions of Office are released with Office functionality as it exists at that time. They’re not supposed to update if there are improvements made later.

      (Although I’ve noticed that they have language about making updates and that sometimes they do seem to make updates, perhaps for security reasons, because I will sometimes notice that my old familiar program isn’t working the way it used to.)

      But the appearance and tasks do seem to stay fixed.

      For example, they changed the appearance of Office with the release of Office 2021, but neither of my laptops, one running Office 2013 and one running Office 2019, were impacted. Also, with Office 2021 it looks like they released the function XLOOKUP to replace VLOOKUP and HLOOKUP, but I didn’t get access to it.

      One of the disadvantages of working with one of the static or “on premise” versions of Office is that you don’t get future improvements like that.

      You also, because Microsoft really wants to push people towards their subscription model, are generally limited to having that static version on only one computer. If that computer dies, oh well, you have to buy it again for the next computer. You can’t transfer it.

      (Again, that’s what they say, but when I logged onto my new laptop with my Microsoft account they were ready to let me use Office 2019 on it even though I’d bought it for my old computer. So maybe it’s more one computer at a time even though that is not what the license says.)

      The advantage to the static versions, though, and the reason I like them, is that they are stable. I buy Office 2019, I figure out how it works, and I’m done until my computer dies.

      I don’t have to worry that I log in and they’ve changed things on me overnight. I am not a user who is on the cutting edge who needs the latest and greatest. And I don’t collaborate which is where a lot of their more recent improvements seem to be focused so the changes they are making are generally ones that I don’t need.

      I just want things to stay the same so I don’t have to think about anything when I’m ready to work.

      Also, I like the static versions because I pay my $300 (or whatever the cost is at the time) once and never have to pay again or worry about losing the ability to edit my files.

      But there are good reasons to use the third product option, Office 365, which is the subscription version of Office and the subject of this book.

      One is that you can have access to Office across multiple devices. I have a few laptops and having Office 365, if I buy the right option, lets me have Office on my Mac as well as all of my laptops for one monthly fee.

      If you’re part of a family who all need access that can be a much cheaper option than paying to put Office on each computer.

      Also, if everyone is using Office 365 then you know that everyone will be on the same page in terms of compatibility. One of the issues that I ran into professionally a number of years ago was that I was using a newer version of Office than one of my clients. I designed an entire workbook for them that did very complex calculations only to find out that they couldn’t use the workbook because the Excel functions I relied on weren’t available in the version of Office they were using. I had to redo the whole thing because they couldn’t upgrade.

      (Of course, that means that if you are going to use Office 365 or even Office 2021, and you’re working with someone outside of your organization, you need to be very careful that you don’t use something available to you (like XLOOKUP or TEXTJOIN) that that person can’t use because they’re using an older version of Office.)

      Office 365 can also be far more portable if you’re willing to put files on OneDrive. (I am not, because I’m a Luddite at heart.) But with Office 365 you can save your files to the cloud and then access them from your other devices.

      Also, it can maybe be a much cheaper option for certain programs. I use Microsoft Access and to add that on to a Microsoft 2021 purchase was going to be a couple hundred dollars. But with Office 365 I can have Access along with everything else I need for, at the moment, $8.25 a month. (Go to the business licenses if you need this.)

      It also spaces out the cost of the product. You don’t have to plunk down all that money on Day 1. But overall Office 365 is probably more expensive for a single user on a single computer than just buying the product with a one-time fee. My laptop that’s running Office 2013 is now five years old. If I were paying $8.25 a month I’d have spent $495 which I think is more than I paid up front. And (knock wood) that computer is still going strong.

      So it’s all about what trade offs you want to make.

      To summarize.

      There are technically three current versions of Office: (a) the free online one, (b) the static version, the most recent of which is currently Office 2021, and (c) the constantly updating version which is called Office 365.

      At the beginner level the differences between the various version should not be significant.

    

  


  
    
      
        
          
          

          
            WHAT THIS BOOK COVERS

          

        

      

    

    
      Let’s talk now about what you will learn in this book, because Excel is an incredibly complex and powerful tool, but it can also get a little overwhelming if you try to cover everything in one go.

      So what I’ve done with the various Excel Essentials series is break that information on Excel down into digestible chunks. And I think I’ve succeeded at that. (At this point the original Excel for Beginners book, which was written for Excel 2013, has over a thousand ratings on Amazon and a rating average of 4.2, so people are generally happy with the level of information covered.)

      This book is a version of that book but written for Excel 365. It focuses on the basics of using Excel. We’ll cover how to navigate Excel, input data, format it, manipulate it through basic math formulas, filter it, sort it, and print your results.

      That should be 95% of what you need to do in Excel day-to-day if you’re an average user. I’ll also cover at the end how to fill in that last 5% on your own.

      (But if you want to keep going with me from there, then there’s Intermediate Excel 365 and 102 Useful Excel 365 Functions which I’ll discuss in a little more detail at the end.)

      The other nice thing about Excel is that there are a number of ways to perform the same task. While I do strongly encourage you to learn the control shortcuts (like Ctrl + C to copy) that I mention throughout this book, there will usually be two or three or even more ways to perform a task that we’ll cover. So if you have a preference for working in a certain way, it’s likely that Excel can accommodate that.

      My default is going to be those older ways of doing things because that lets you work across all versions of Excel you may encounter. But when I see that something new works better, I will definitely show that you that method as well.

      Okay. So I hope at this point you know that Excel is worth learning.

      And I want you to know before we begin that it doesn’t have to be hard to learn. Trust me and stick with me through this book and you will have the solid foundation you need.

      This book is written to be read start to finish. I want you to read the whole thing. But it’s also hopefully organized in such a way that you can come back to it later and use it as a reference for years to come. In the print version there is an index at the end that lists everything we covered and where to find it. (In the ebook version, search will be your friend.)

      Now, because this book is about Excel 365, I do need to warn you before we start that Office 365 is a moving target. It is always going to be the latest and greatest. Which means that this book is taking a snapshot of Office 365 as it exists in December 2022, but Office 365 changes monthly.

      By the time you read this book, whenever that is, there may be more functionality available than I cover here.

      Usually, though, that more is not going to impact beginner-level material. For example, the August 2022 update to Excel 365, added a new function (XLOOKUP) and the ability to have “sketched” shapes to make your diagrams and models look hand-drawn, thereby distinguishing ones that were “in progress.” Not exactly things that will impact someone new to Excel.

      So there will be some changes, but don’t worry about them. If I ever think this book isn’t a good beginner resource anymore, I will unpublish it or update it. So if you are buying this book new then that means I still think it works for new users and it will still teach you what you need to know to use Excel on a day-to-day basis.

      I’m going to be working with the desktop version of Office 365. If you are working online your functionality may be more limited. (That is probably an especially good time to know the control shortcuts.)

      Also, your save/open options may be slightly different due to that need to “upload” files or save them to OneDrive.

      Okay, one more thing before we get started, which is how to change your appearance, and then we’ll dive right in with terminology and absolute basics.
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      Depending on how you have your appearance set, your version of Microsoft Excel may look very different from the screenshots I’m going to use in this book. So before we start I wanted to show you how to change that appearance to match mine in case you want to do that.

      If you are absolutely brand new to Excel you may have to come back to this chapter since it relies on having opened an Excel file and knowing some terminology, but I wanted to cover it here before I show you that first screenshot.

      To change the appearance of your Office programs, open Excel. That should show you a welcome screen:

      
        
          [image: Excel Welcome Screen]
        

      

      If you don’t get that screen, open an Excel file and click on the File option in the top left corner. From there you have two choices. You can either click on Account or Options in the bottom left corner of the screen. Here I’ve clicked on Account. You can see in the main workspace that there is a dropdown menu for Office Theme. Note that I have mine currently set to Colorful.

      
        
          [image: Account Screen]
        

      

      If you click on Options instead, then you can find this same setting under Personalize Your Copy of Microsoft Office in the General section:

      
        
          [image: Options dialogue box]
        

      

      There will be a dropdown menu for Office Theme there as well. Let’s look at the different options now.

      This is the Dark Gray theme:

      
        
          [image: Dark Gray theme]
        

      

      This is the Black theme (which is especially drastic in Word):
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      This is the Colorful theme:

      
        
          [image: Colorful theme]
        

      

      This is the White theme:

      
        
          [image: White theme]
        

      

      You can’t see this in the black and white print version, but the Colorful theme uses blue for the top bar in Word, green for the top bar in Excel, and I would presume orange and red for PowerPoint and Access respectively.

      There is also a system settings choice which I presume will be different for everyone based upon the Windows theme they’re using. If you have any sort of sight impairment, there are some pretty funky choices you can make in the Windows settings that you may want to explore, but I’m not going to here. One of them for example uses black and bright yellow.

      For the rest of this book I’ll be using the Colorful theme but it will look just like the White theme most of the time because I won’t include the very top of the screen in most of my screenshots.

      Whichever choice you make will apply across all of your Office programs, so be careful there. Or be prepared to change it when you move between programs if you have different preferences in different programs.

      Okay, now we can cover terminology.
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      Before we can dive in on how to do things, we need to cover some basic terms.

      I’m going to assume here you really don’t know any of the basics, so you can skim if you think you do, but be sure to at least glance at the headers because I may have my own idiosyncratic way of describing things that you won’t have encountered elsewhere.

      

      
        
        Workbook

      

      

      A workbook is what Excel likes to call an Excel file. They define it as a file that contains one or more worksheets. In current versions of Excel a workbook will by default start with one worksheet in it, but you can add more as needed.

      

      
        
        Worksheet

      

      

      Excel defines a worksheet as the primary document you use in Excel to store and work with your data. It can also sometimes be referred to as a spreadsheet, but I will try to avoid using the term spreadsheet here because when I use the term spreadsheet I sometimes actually mean the whole workbook. So better to stick to workbook and worksheet whenever possible.

      A worksheet is organized into Columns and Rows that form Cells.

      

      
        
        Columns

      

      

      Excel uses columns and rows to display information. Columns run across the top of the worksheet and, unless you've done something funky with your settings, are identified using letters of the alphabet.

      As you can see below, each worksheet will start with A on the far left side for the first column and march right on through the alphabet (A, B, C, D, E, etc.) from there.

      
        
          [image: Columns]
        

      

      If you scroll far enough to the right, you'll see that the columns continue on to a double alphabet (AA, AB, AC, etc.) and then on to a triple alphabet (AAA, AAB, etc.).

      As of right now the very last column in a worksheet is XFD.
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      You can reach the very last column in a blank worksheet by holding down the Ctrl key and pressing the End key which is usually also the right arrow key.

      If there is already data in that worksheet using Ctrl + End will take you to the last column that has data in it, so you’ll need to use Ctrl + End again to go to the last column in the worksheet.

      We’ll touch on this again, but column letters are basically a way of numbering the columns, not an attribute that is specific to a column. So Column A is always the first column. Column B is always the second column. Etc. And there are always going to be the same number of columns in your worksheet regardless of whether you delete or insert columns.

      When you delete or move information in a column you’re just moving the data. The grid system doesn’t move. So if I take Column A and I delete that column there will still be a Column A because there is still always a first column. And if I were to take all of the data in Column A and move that data three columns over it would now be in Column D.

      So think of columns as location information that is actually separate from the data in the worksheet. (We’ll work through this more, don’t worry.)

      Also, columns are one of those areas where you need to be careful if you’re working with someone with an older version of Excel because they may not have as many columns in their worksheets in their version of Excel as you do.

      For example, I have Excel 2013 on one of my laptops and my last column in that version is IV which means I have far far fewer columns in my version of Excel than anyone using Excel 365 does. This could mean that I would lose data if I open a file from an Excel 365 user in Excel 2013 if that file uses more columns than I have access to.

      So always keep in the back of your mind that if you’re working with others that aren’t set up the same way you are in Office that you can have compatibility issues and one of the main ones you can have is number of rows and columns.

      But let’s get back to basic terms.

      

      
        
        Rows

      

      

      Rows run down the side of each worksheet and are numbered starting at 1 and up to a very high number. As of now that number is 1048576. That means a single Excel worksheet currently has over a million rows. You can hold down the Ctrl key in a blank worksheet while hitting the down arrow to see just how many rows your version of Excel has.
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      As a comparison, Excel 2013 had only 65,536 rows in a worksheet. Keep this in mind for compatibility issues when working with other users.

      And, once more, those row numbers are locational information. The first row will always be numbered 1. The second row will always be numbered 2. And so on and so forth. And at least as of this moment there will always be 1,048,576 rows in every Excel worksheet at all times. So even if you delete or insert rows, that will not change that fact. You are deleting data not the number of rows in the worksheet.

      

      
        
        Cells

      

      

      Cells are where the row and column data all comes together. Think of it as map coordinates. Cell A1 is the first column and first row of the worksheet.
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      When you click onto a specific cell, like I have above, that cell will be surrounded with a darker border around the perimeter.

      You can also look in the Name Box, noted above, to see the cell reference for that cell. These cell references are used when writing Excel formulas or using functions.

      And remember, that these are coordinates, they are not fixed to your data. So if you have an entry in the first column of the first row of your worksheet and move that entry to the third column and third row of your worksheet that entry will now be in Cell C3 not Cell A1.

      (Again, don’t worry too much right now, we will work in Excel and you will see how this happens.)

      

      
        
        Click

      

      

      If I tell you to click on something, that means to use your mouse (or trackpad) to move the cursor on the screen over to a specific location and left-click or right-click on the option. (See the next definition for the difference between left-click and right-click).

      If you left-click, this selects the item. If you right-click, this generally displays a dropdown list of options to choose from. If I don't tell you which to do, left- or right-click, then left-click.

      

      
        
        Left-click/Right-click

      

      

      If you look at your mouse you generally have two flat buttons to press. One is on the left side, one is on the right.

      If I say left-click that means to press down on the button on the left. If I say right-click that means press down on the button on the right. (If you're used to using Word you may already do this without even thinking about it. So, if that's the case then think of left-click as what you usually use to select text and right-click as what you use to see a menu of choices.)

      If you’re using a track pad, not all track pads have the left- and right-hand areas visible. In that case, you’ll basically want to press on either the bottom left-hand side of the track pad or the bottom right-hand side of the trackpad as needed.

      

      
        
        Select

      

      

      If I tell you to "select" cells, that means to highlight them. If the cells are next to each other, you can just left-click on the first one and drag the cursor (move your mouse or finger on the trackpad) as you hold that left-click until all of the cells are highlighted.

      (I will refer to this action as left-click and drag.)

      When you do this, all the selected cells will be shaded gray and surrounded by a dark box like below except for the first cell you clicked on which will be within the perimeter of the box but will be white.
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      You can also select cells that are not next to each other by holding down the Ctrl key as you left-click on each cell.

      
        
          [image: Selected cells non-contiguous]
        

      

      When you do that, each selected cell will be shaded gray except for the last selected cell which will be surrounded by a border but will be white. Above I selected Cells A1, A3, C1, and C3. C3 was selected last.

      To select an entire column, click on the letter. To select an entire row, click on the number.

      For any row or column where a cell is selected in that row or column, the number or letter for that row or column will be shaded differently. In my version right now with my settings it’s shaded a darker gray and the number/letter turns green.

      For any row or column where the whole row or column is selected that letter or number will change to a different shading. For my version with my settings it turns light green with a dark green number/letter.

      

      
        
        Data

      

      

      Data is the information you enter into your worksheet. It’s the values and text that you input or calculate. I will also sometimes refer to this as information, values, or text.

      

      
        
        Data Table

      

      

      I may also sometimes refer to a data table or table of data. This is just a combination of cells that contain data in them.

      One thing to keep in mind with Excel versus Word if you’re coming from using Word is that in Word when you create a data table you are adding a specific number of rows and columns into Word to do that. But in Excel the number of rows and columns never changes. What does change is how many of those rows or columns have your data in them.

      Excel is smart enough to only print or focus on the rows or columns with data in them, but if you want something to print out and look like a table you could create in Word you’ll want to put borders around your data in Excel. (We’ll discuss how to do that, don’t worry.)

      (This is a question that came up a few times after I released Excel for Beginners, so I wanted to mention it here specifically. Data tables as you create them in Word are not the same as data tables as you use them in Excel.)

      

      
        
        Arrow

      

      

      I will sometimes tell you to arrow to somewhere. Or to arrow right, left, up, or down. This just means to use the arrow keys. Using arrows is one way to move between cells within an Excel worksheet.

      The other ways are to left-click on a cell. Or you can use Tab and Shift + Tab to move right and left, respectively. And Enter to move to the next row.

      

      
        
        Cursor Functions

      

      

      The cursor is what moves around when you move your mouse or use the trackpad. In Excel the cursor changes its appearance depending on what functions you can perform. You can see this by opening an Excel file and moving your cursor over the cells and then along the edges of a row or column and then up to the menu options up top.

      

      
        
        Tab

      

      

      I am going to talk a lot about Tabs, which are the options you have to choose from at the top of the workspace.

      
        
          [image: Menu tabs]
        

      

      It used to be, in older versions of Excel that when you clicked on one of these options it took on the appearance of a tab like a file folder has. But in the latest versions of Excel that’s no longer the case. The selected tab is just underlined. For example, in the image above, I have the Home tab selected which you can tell from the solid line under the word Home.

      Each tab has a number of options available. Here is the left-hand set of options available under the Home tab, for example:

      
        
          [image: Home tab left-side options]
        

      

      I can Undo, Copy/Paste/Format Sweep, choose my font attributes, choose my text alignment, etc.

      The Home tab is the tab that will be selected by default. But you can click on the other tabs to see their available options.

      Throughout this book I will often tell you to go to Y section of X tab and choose the task that we’re trying to complete. For example, if I wanted you to change the font from Calibri to something else, I would say you could go to the Font section of the Home tab and click on the dropdown menu for font. (I will include screenshots most of the time so you can also see what I’m talking about.)

      

      
        
        Dropdown Menus

      

      

      A dropdown menu is a listing of available choices that you can see when you click on the arrow for that option or right-click in certain places such as the main workspace.

      For example, here is the font dropdown menu:

      
        
          [image: Font dropdown menu]
        

      

      I clicked on the small arrow next to the current font name and that brought up a listing of choices. There are a large number of dropdown menus in Excel as you can see here where we have dropdown menus for Undo, Paste, Copy, Font, Font Size, Underline, Borders, Fill Color, Font Color, and Text Orientation:

      
        
          [image: Home tab dropdown menu examples]
        

      

      There are many more available in Excel. So any time I tell you to use a dropdown menu or anytime you’re trying to find additional options, look for that little arrow to the right of or below the task you’re trying to complete or try right-clicking on a worksheet name or in the main workspace.

      

      
        
        Help Text

      

      

      This isn’t really a term and we’ll discuss it again later, but I just wanted to mention that if you are ever unsure what task an image in the top menu is related to, you can usually hold your mouse over the image and Excel will tell you what it is. Here, for example, I held my cursor over the image of a bucket with a bright yellow line under it and Excel showed me a pop-up box that tells me that’s for adding Fill Color and what that does. I can then click on Tell Me More to open Help and learn more about how it works.

      
        
          [image: Help Tell Me More example]
        

      

      Tell Me More is not always available, but usually you will at least get a brief description of what that image will let you do.

      

      
        
        Dialogue Boxes

      

      

      Dialogue boxes are pop-up boxes that contain additional choices. You will often see one if you click on the arrow in the corner of a section of a tab. For example, here I have clicked on the arrow in the corner of the Font section of the Home tab and that has opened the Format Cells dialogue box.

      
        
          [image: Format Cells dialogue box]
        

      

      Dialogue boxes often have the most available choices. So if you aren’t seeing what you want in the tab choices, then click on that arrow to open the related dialogue box if it exists.

      Also, for those who are used to older versions of Excel, dialogue boxes are likely what you’re used to working with so using them can sometimes feel more familiar than using the options up top.

      You will also sometimes see a dialogue box if you right-click and choose an option from the dropdown menu in the main workspace.

      

      
        
        Scroll Bars

      

      

      When you have more information than will show on the screen, dialogue box, or dropdown menu you can use the scroll bars to see the rest of the information.

      The main scroll bars you will see are going to be in the main workspace when there is more data in your rows and columns than can appear on the screen:

      
        
          [image: Main workspace scroll bars]
        

      

      Scroll bars usually appear on the right-hand side or on the bottom of the workspace, dialogue box, or dropdown menu.

      In the image above you can see them as darker gray bars. Note that there are also arrows at each end of the scroll bars. And that there is blank space between the arrows and those bars.

      The more information involved, the smaller the scroll bars will be and the more space there will be around them.

      There are three ways to navigate using the scroll bars.

      You can left- click and drag the bar itself. This means, left-click on the bar, hold down the left-click, and move the cursor as you do so. The bar will move and the visible information will change.

      If you only want to move a small amount at a time, you can use the arrows. Arrows at the bottom will move one item left or right, arrows on the side will move one item up or down.

      You can also, left-click and hold on the arrows to move through multiple items but it will do so one at a time.

      The final option is to click into the gray space between the two. One click in that gray space will move you an entire screen’s worth. So in the main workspace if I can see Columns A through V and I click in the gray space at the bottom that moves me to Columns W through AR.

      In the main workspace, you can only use the scroll bars or click into that gray space to navigate within the area where you have data. But the arrows will let you go past that.

      

      
        
        Formula Bar

      

      

      The formula bar is the long white bar at the top of the main workspace directly below the menu tabs that lets you see the actual contents of a cell, not just the display value.

      Here you can see that the value in Cell C1 is 5, but according to what we can see in the formula bar, that value is calculated using the formula =A1+B1, which adds the values in Cells A1 and B1 together:
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        Task Pane

      

      

      On occasion Excel will open a task pane, which is different from a dialogue box because it is part of the workspace. You can use F1 to see an example of this with the Help task pane which opens on the right-hand side of the workspace.

      
        
          [image: Help task pane]
        

      

      They can be closed by clicking on the X in the top right corner.

    

  


  
    
      
        
          
          

          
            ABSOLUTE BASICS

          

        

      

    

    
      Before we start working in an Excel workbook, I want to cover the absolute basics of opening, saving, closing, and deleting files.

      If you’re already familiar with Microsoft Word or another Office program or similar, then this will probably all be familiar to you, but I want to make sure it’s here for those who aren’t.

      

      
        
        Open a New Excel File

      

      

      If you want to start a brand new Excel file, the first step is to open Excel. How you do this will depend on how you have your computer set up and what version of Windows you’re running.

      One of the first things I do when I get a new computer is I add my key programs to my taskbar. That way when I want to open Excel I can just click on the icon for Excel and open the program.
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      In Windows 11, a simple click on that green icon with the X will open Excel.

      If you aren’t set up with that, then you may have an Excel shortcut on your desktop.

      Or you can go to the Start menu in the bottom left corner of your computer (if you haven’t moved things around), left-click on that blue window icon and it will show you a menu where Excel may be in your pinned apps. If it’s not there you can search for it. Or you can go to All Apps and find it there.
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      This is Windows 11. Windows 10, you click on the Start menu icon and look for the All Apps listing and then find it that way. They’ll probably change it again in Windows 12 or whatever comes next, because they seem to love to do that, which is why I find it once, right-click, and choose to Pin to Taskbar so it’s right there when I need it.

      Okay. So however you do it, open Excel. If this is your first time in Excel you may have to Activate your account or skip through some screens that want you to activate it. But after you do that, you’ll have something like this:
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      This is the Excel welcome screen. I’ve grayed out the section with my recent files listed, but otherwise this is what you should see when you first open Excel.

      Those appearance settings we talked about before can be changed using Options on the left-hand side, bottom corner.

      But if you’re there to start a new file, then click on the Blank Workbook choice at the top of the screen.

      (You’ll see that there are also a number of templates you can choose from, but for what we’re going to do in this book you can ignore those for now. If at some point you want to create an expense report, for example, you may want to click on that template and adjust from there.)

      You could also click on New on the left-hand side but that just takes you to another screen where you have the Blank Workbook and template choices once more.

      Clicking on Blank Workbook will open a new, blank workbook for you that looks like this:
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      If you are already in an Excel workbook and want to create a new workbook, you have a couple of choices. The easiest is to use Ctrl + N. That will immediately create a new workbook for you.

      You can also go to the top of the screen, click on the File option, and then click on Blank Workbook from there.

      

      
        
        Open An Existing Excel File

      

      

      If you already have an Excel file and now want to open that file and work on it, there are a couple of options available.

      The first is to find the Excel file wherever you have it saved and double-click on it. That will open the file in Excel and if Excel isn’t already open will also open Excel for you.

      If you do have Excel open and you’ve recently used that file, then you should be able to find it in your Recent Files listing on the welcome screen when you open Excel.

      You can see in the image below the four most recent files I’ve opened in Excel and when they were opened last. My screen actually shows eight files and if I scroll down there are two more for a total of ten.
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      Click on the file name and the file will open.

      There may be times when a file is listed in your recent files list but you can’t open it from there. This happens if you move the file or change its name outside of Excel.

      For a file that you want to open that isn’t in that recent files list, click on Open from the welcome screen. You will once more see the Recent Files listing, but there will also be other options. One of those is the Folders option. Click on that and you’ll see a listing of any folders that contain files you recently opened.
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      You can see in the image above that I opened files from the Writing Files and Excel 2019 Formulas and Functions folders today and have opened files from my Desktop, Downloads, Access DB for Writing, and a zip file this week.

      This can sometimes be the easiest way to find a file you’re looking for if you tend to store your Excel files in just a handful of locations. Click on one of those folder options and you’ll see a listing of Excel files that are in that folder. You can then click on that file name to open it.
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      That will often be the best way to find a file. But it doesn’t work if the folder the file is in is one you haven’t used recently. It also doesn’t work if the file you want to open isn’t one of the main types of files that Excel can open, namely, .xls, .xlsx, or .csv.

      If that’s the case, then click on the Browse option instead. This will open the Open dialogue box.
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      You can then use the options on the left-hand side to navigate to the folder that contains your file and select the file that way.

      One of the files I need to open in Excel is a .txt file. By default, Excel will not look for that file type. You can see here that it’s not showing any files for me to open.
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      When I need to open one of those Text files, I have to change the file type in the Open dialogue box by clicking on the dropdown menu for file type and changing it to All Files from All Excel Files. Once I do that, I can then see the file I need to open and select that file:
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      But that’s a pretty rare situation, so usually you won’t need to worry about that. I just mention it here because for anyone who publishes through Apple, their reports are text files. (That you also have to open with 7-Zip.)

      Okay, back to things that matter to most readers instead of just one little subset.

      If you already have Excel open and are either working on a file already or are in that main workspace and want to open another file, you can either use Ctrl + O, which will take you to the Open screen, or you can click on File at the top of the workspace and then click on Open.

      From there it’s the same steps as we just walked through.

      

      
        
        Pin A File

      

      

      If you have a file that you always want readily accessible but that won’t stay in your recent files listing because you open enough files that it sometimes falls out of your top ten most recent, then you can Pin that file and it will always be available to you in your Pinned files section.

      For example, I have a monthly profit and loss Excel file that I like to review once a month. But it gets lost from my recent files list because when I load all of my sales reports there are more than ten of them. So to make sure I can always find that file, I pin it.

      To do this, find the file in your recent files list. Hold your cursor over that listing. You should see the image of a thumbtack appear on the right-hand side, and if you hold your cursor over that image it will say, “Pin this item to the list”.
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      Click on that thumbtack. If you then click onto the Pinned option, that file will be listed there. And it will stay there regardless of what other files you open, so that it’s always available to you.
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      Once you’ve pinned a file, you can open it by going to your Pinned Files section and clicking on that name.

      

      
        
        Close a File

      

      

      If you ever have an Excel file open and want to close it, you can use Ctrl + W. I personally never remember that particular shortcut, so I instead just click on the X in the top right-hand corner.

      
        
          [image: Close file option]
        

      

      You can also click on File in the top menu on the right-hand side and then click on Close from the list of options on the left-hand side of the File screen.

      

      
        
        Save a File

      

      

      If you’ve made changes to a file and you try to close it Excel will show you a dialogue box that asks if you want to save those changes.
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      It gives you three options, Save, Don’t Save, and Cancel.

      Save will overwrite the existing version of the file. You’ll keep the same file name, file location, and file type. All changes you made while that file was open will be saved. Whatever the file was like before that, is gone.

      Don’t Save will close the file but not save any changes you made to the document while it was open. It will be like you never touched that file.

      Cancel will not close the file and also not save the changes. Choose Cancel if you want to save the file as a new version and not overwrite the old version.

      If you’re trying to close a brand new file, choosing Save will actually open the Save As dialogue box, because Excel doesn’t know where you want to save the file or what you want to call it.
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      It will default to wherever the last file you opened was saved and the name will be some variation on Book 1. (If you have multiple blank workbooks opened it may be Book 2 or Book 3, etc.)

      Type in the new name you want. Use the folders on the left-hand side of the dialogue box to navigate to the folder where you want to save that file. And make sure that the file type is what you want to use. Normally you’ll be fine sticking with a file type of Excel Workbook.

      But file type is another area where you may run into issues if someone is using an older version of Excel than you are. In that case, change the file type to Excel 97-2003 Workbook.

      Be careful doing this, though, because as Excel adds more and more bells and whistles and functionality it makes it more and more likely that the Excel 97-2003 file format is not going to be able to support something you did in your Excel file.

      If you’re ever looking at file extensions, this is the difference between a .xlsx file and a .xls file. All files before Excel 2007 were .xls files. All files since then are .xlsx. In the past I advised saving to .xls for compatibility reasons, but I think we’re far enough along at this point with .xlsx that you don’t need to do that by default anymore. And if you’re only working on files for yourself or your organization, you absolutely shouldn’t need to worry about that.

      If that all sounded confusing, don’t worry. Just save as Excel Workbook. And if someone ever says, “I can’t open that file because I have an older version of Excel,” then come back to this section at that point in time.

      So that’s how you save a file if you weren’t being proactive about it and just waited for Excel to remind you to save your file before you closed it.

      But it’s possible you will want to save that file under a new name or in a new location or as a new file type. Or that you’ll want to save as you work so that if your computer crashes you don’t lose your work. (Not as much of an issue these days as it was in the past, but it can still happen.)

      In that case, let’s start with Save first. Save is for a file where you want to save the changes you’ve made but you don’t need to change the name, location, or file type.

      The easiest option is Ctrl + S. That will save all of the changes you’ve made so far and overwrite the former version of the file.

      If the file has never been saved before it will take you to the Save As screen under the File tab.

      You can also click on the computer disk icon in the top left corner of the screen. Hold your mouse over it and it will say Save (Ctrl + S). Click on that and that too will save any changes you’ve made so far and overwrite the existing file.
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      To save the file you’re working on under a new name, into a new location, or as a new file type, you need to use Save As. To do that, click on File in the top left corner and then choose Save As.
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      If you just need to change the file name, you can do so right there. Same with the file type. Once done click on Save.

      To change the location, click on the Browse option. That will bring up the Save As dialogue box and let you navigate to the new location you want. Clicking on More Options will also bring up that dialogue box.

      Keep in mind with Save As that the original file will still exist. So if you want multiple versions of a file, which I sometimes do when I’m building something really complex, that’s great. But if what you really wanted was to change the file name or move the file, then you probably don’t want to use Save As to do that.

      

      
        
        Change a File Name

      

      

      To change the name of an Excel file you can use Save As as we just discussed but that will leave you with two files. The original file will have the original name and then the newly-saved version will have the new name.

      But if you don’t need two files, it’s better to close the Excel file, go directly to the folder where you have the file saved and change the name there. To do so, click on the file once to select it, and then click on it a second to make the name editable.
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      You can see here that I’ve done that with the third listed file so that the text of the name is now highlighted. I can then click into that field and make whatever change I want to the name. When you’re done, hit Enter.

      If you change a file name in this way, you will not be able to use the Recent or Pinned file listing to open the file the next time you go to open it in Excel. You will have to open the file directly from where it’s saved or use the Browse option.

      

      
        
        Delete a File

      

      

      If you ever want to permanently delete an Excel file. Say, for example, that you did use Save As but don’t need that original file anymore, this has to be done outside of Excel. Close the file in Excel and then go find where you have it saved. Click on the file name once to select it. And then click on the trash can icon at the top of the window. You can also right-click on the file name and click on the trash can from there (for Windows 11) or choose Delete from the dropdown menu (for Windows 10).

      

      
        
        File Naming Tip

      

      

      Before we close out this chapter, I just want to share a file-naming tip I picked up from an efficiency training years ago that’s been very helpful for me. I do keep multiple versions of files. For example, when I publish a book there’s the original file. And then if I later make an edit because I find a typo or I release a new book in that series that needs to be added to the Also By section, there’s another file. Some of my titles have twenty versions because they’ve been out almost a decade by now.

      I want those files to display in an order that lets me quickly find the most recent one. To make that happen, I use a YYYYMMDD naming format.

      This book for example would be “Excel 365 for Beginners 20221210”. And then if I made an edit on December 15th it would be “Excel 365 for Beginners 20221215”. By writing the date in that order—year, month, day—it ensures that when I sort by name, the files sort in proper date order.

      (And if I ever for some reason have two on the same day then I add v1, v2, etc. at the end.)

      You can use this same trick for folder names as well.

      Also, if you have a process that involves multiple files and steps, consider how things will sort there as well. For example, I have put some of my books out as audiobooks. And there are four steps I go through to get to the final file. I have the raw recording, the first pass edit, the Reaper processing, and then the final version. I want to keep all of the raw files together, all the first pass files together, etc. And I want them in order.

      So in that case I name the files “Raw 1 Introduction”, “First Pass 1 Introduction”, etc. By putting the stage of production first that makes sure that the raw files for all fifteen chapters group together. And by using the chapter number next I make sure that the first file in each group is the first chapter.

      You will save yourself a lot of headache if you give some thought to your file names up front. And if you don’t do so, well, you can always go and rename those files later. Just remember to do it where you saved the files not through Excel.

      Okay. Now that we know how to open, close, save, rename, and delete files, let’s talk about how to navigate Excel.

    

  


  
    
      
        
          
          

          
            NAVIGATING EXCEL

          

        

      

    

    
      I want to talk now about how to move around within an Excel worksheet as well as within an Excel workbook and between workbooks.

      

      
        
        Move Between Excel Workbooks

      

      

      Let’s start with the easiest one. If you have two Excel workbooks open, the easiest way to move between them is using Alt + Tab. If you have more than two files open just keep using the Tab key while you hold down the Alt key to cycle through until you reach the one you want.

      Alt + Tab lets you cycle through all of your open files or programs, not just Excel.

      Items will usually be listed in order of when you last used them, so if you’re moving back and forth between two Excel files, even if you have ten items open, those two files should be your first option each time you move. That means just one use of Alt + Tab will take you to the other file.

      Another option, is to hold your mouse over the icon for Excel in the taskbar and then choose the file you want that way by clicking on the thumbnail image for the file.
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        Move Between Excel Worksheets

      

      

      Within an Excel file it is possible to have multiple Excel worksheets. I usually just click on the name of the worksheet I want at the bottom of the workspace.

      You can see which worksheet you are currently on by seeing which worksheet name is white with bolded text.
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      There is also a control shortcut for moving between worksheets that I generally don’t use. Ctrl + Page Up will move you one worksheet to the left and Ctrl + Page Down will move you one worksheet to the right. If like on my computer your Page Up and Page Down buttons are combined with your up and down arrows then you may need to use Ctrl + Fn + Page Up and Ctrl + Fn + Page Down.

      This does not, as of this moment, cycle through to the start or to the end. Meaning, if you have twenty worksheets and want to get from the first to the last, you would have to use Ctrl + Page Down nineteen times. Just using Ctrl + Page Up isn’t an option. (It would be nice if it was, though, so maybe they’ll do that someday.)

      If you have more worksheets in your file than can be displayed at the bottom of the workspace, there will be little … at the end of the visible worksheet names.
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      Click on that … to see more worksheets.You can also use those left and right arrows on the bottom left corner of the workspace to move left or right and show more worksheets.

      Using Ctrl and left-clicking on one of those two arrows will take you all the way to the first sheet or all the way to the last sheet, depending on which arrow you click on.

      You can also right-click on one of those arrows to bring up an Activate dialogue box listing all of your worksheets in your workbook. From there click on the name of the worksheet you want and then click on OK and Excel will take you to that worksheet.
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      (If you don’t want to try to remember those last two, holding your mouse over the arrows will tell you that as well. When in doubt in Excel, try holding the cursor over something because often there will be additional help text that appears.)

      

      
        
        Move Within An Excel Worksheet

      

      

      Any brand new Excel workbook is going to open on Sheet 1 and in Cell A1. To move from there, as we discussed briefly in the terminology section, you have a few options.

      You can simply use the arrow keys to move one cell in any direction. So, right arrow moves you right one cell to Cell B1. Or if you used the down arrow it would move you down one cell to Cell A2. And then once you’re not pinned into a corner in Cell A1, you can also use the left arrow to go left one cell and the up arrow to go up one cell.

      The Tab key will also let you go right one cell. And using Shift and the Tab key will let you go left one cell.

      Enter will also move you down one cell. Although, sometimes if you’re entering data Enter will actually move you down one row but over to the beginning of where you were entering your data. So, for example, if I put “a” in Cell A1, “b” in Cell B1, and “c” in Cell C1, and then hit Enter that will take me to Cell A2. This can be very useful when entering multiple rows and columns of data directly into Excel.

      Page Up and Page Down will take you one full screen’s worth of rows up or down. (You may need to use Fn + Page Up and Fn + Page Down depending on how your computer is set up.)

      You can also simply left-click into whichever cell you want if it’s visible in your workspace.

      As discussed more fully in the terminology section, to move greater distances within a file, you can use the scroll bars, the arrows at the end of the scroll bars, or click on the gray space between those arrows and the scroll bars. But be careful using those, because what you see will adjust, but until you click into a cell in the worksheet, you will still be in the last cell you were clicked into or edited.

      This has occasionally tripped me up when I have my panes frozen (something we’ll talk about later) and then I scroll far down in my data, but forget to click into one of the cells I can see on the workspace and so hit enter and am suddenly back at Row 2 instead of Row 2,354 or whatever.

      Also, as mentioned before, according to Microsoft’s help, Ctrl + End and Ctrl + Page Down will move you to the end of a range of data or the end of your worksheet, depending on if there’s data in the worksheet.

      Likewise, to go from somewhere in your worksheet to the top or the left-most edge, you can use Ctrl + Page Up and Ctrl + Home.

      For me, with a computer where my arrow keys are combined with my Page Up, Page Down, Home and End keys I just have to use the arrow keys. I don’t need to add the Fn key in to this one to get to Page Up, Page Down, Home, and End. So you may need to experiment around a bit to see how your particular computer acts.

      Also, the help text on this one seems to differ from how it actually works. The help text says it takes you to the outer range of any existing data, but from testing it, what it actually does is takes you to the end of the next set of data in that particular row or column.

      So if Column A has data for six rows and Column B has data for ten rows, depending on which column you’re in when you use the shortcut you may go six rows or you may go ten.

      If you do use this, and it can be very handy especially when paired with Shift so that you select those cells at the same time, watch out for gaps in your data. If there is an empty column or an empty row, Excel will stop at that gap. You’ll need to use the arrow/page up/page down/home/end key again to grab the full range of your data if that happens.

      

      
        
        Freeze Panes

      

      

      If you have a lot of information in a worksheet, Freeze Panes will save you. Because it lets you keep certain information, such as a header row, visible in your workspace while you scroll down to see more data. Without freeze panes you end up with a screen full of data but nothing that tells you what that data is.

      Here, for example, is a few rows of data from one of my Amazon reports:
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      If you wanted to use one of those columns to know the total number of units sold, which one would you use? And which one would show list price of the book? Versus which one shows what a customer actually paid for the book? Some of it is self-explanatory, but not all of it.

      This particular report also has 15 columns, which means that I either would need to Zoom Out and make the text smaller to see everything or I’m going to not be able to see the left-most columns when I’m looking at the right-most column.

      Which is a problem. I have it hidden right now, but Column B is Title and looking at how much I earned in the second-to-last column doesn’t do me much good if I don’t know which book it is.

      But Freeze Panes lets me solve this issue. Because I can set up this worksheet so that Row 1 is always visible even when I’m on Row 250. And I can also set it up so that my title column is always visible, too.

      Like so:
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      See how it goes from Row 1 to Row 224? And how it shows Columns A and B and then Columns N and O? All of the other rows and columns are still visible, but I’ve scrolled down and over to see this information.

      So how do you set this up?

      If all you want is to freeze the top row of your worksheet or the first column, go to the Window section of the View tab and click on the dropdown arrow for Freeze Panes. Choose either Freeze Top Row or Freeze First Column.
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      You can do one or the other this way, but not both. If you want to freeze more than one column, more than one row, or columns and rows both at the same time, then you need to first click into your worksheet at the first cell that you are okay not seeing.

      In other words, below the rows that you want to freeze in place and to the right of the columns that you want to freeze in place.

      So in our example worksheet, I want to keep the first row visible and I want book title visible, which is in the second column. That means I need to click into Cell C2.
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      In the image above you can see that I’ve shaded the first row gray as well as the two columns on the left gray so that I can make it more clear which data will remain visible.

      I can then go to the Freeze Panes dropdown and choose the first option, Freeze Panes, to keep both that top row and the left two columns visible.

      Now, honestly I don’t care about keeping the date visible, but with freeze panes you don’t get to be that specific. So it’s everything to the left and everything above the cell you choose. Which means if I want book title I am also going to get date.

      (I could hide a column or move a column to fix that, but it’s not that big a deal to me.)

      To remove freeze panes, just go back to that same dropdown menu. The top option will be Unfreeze Panes now and you can just click on it to remove any freeze panes that are in effect.

      Now, one thing to be careful of, that I do more than I should. If you are clicked into Row 1 and have freeze panes in effect and have scrolled down to Row 10,522 but not clicked into any cell in that row or in that part of your data, you are still on Row 1 as far as Excel is concerned. And so if you use your down arrow you will go to Row 2 and the rows you see on your workspace will change to Rows 2 through…37 or so. And then you’ll have to scroll all the way back down to Row 10,522 again.

      Also, don’t try to freeze too many rows or columns at a time. If you freeze the majority of your screen then you’ll only be able to scroll maybe one record at a time which is very inefficient.

      

      
        
        Hide Columns or Rows

      

      

      Sometimes when I’m working with data in Excel there will be rows of data or columns of data I really don’t need to see at all. So it’s not that there’s so much information on the screen I can’t see it all, it’s more that I want what’s in Column B next to what’s in Column F. Maybe I’m inputting data into those two columns, but there are calculations between the two that I want to stay where they are. So while I’m adding my information I don’t need to see the calculation columns, just the columns where I’m putting in information.

      When that happens I hide those rows or columns I don’t need to see.

      To hide a row or column, right-click on the letter or number for that column or row, and choose Hide from the dropdown menu.
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      When you hide a column it still exists, so you will see that the letters or numbers skip that missing column or row. It will go from Column C to Column E, for example, if you’ve hidden Column D like I have in the screenshot above.

      To unhide hidden columns or rows, select the columns or rows on either side of the hidden entries and then right-click and choose Unhide.
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      Now let’s talk about inputting data after which we’ll talk about inserting and deleting rows, columns, and cells as well as a bit more about working with worksheets.
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      At its most basic, inputting your data is very simple. Click in the cell where you want to input information and then type. But there are some tricks to it that you’ll want to keep in mind.

      First, let’s take a step back and talk about one of the key strengths of using Excel and that’s the ability to sort or filter your data.

      For example, I publish books and every month I get reports from the places where my books are published listing all of the sales of my books at those locations.

      But what if I only care about the sales of book A? How can I see those if I have a couple hundred rows of information in the report they’ve given me?

      Well, if the site where I sold those books is nice and helpful and they understand data analysis, they’ve given me my sales listings in an Excel worksheet with one header row at the top and then one row for each sale or for each book.

      If they’ve done that, then I can very easily filter my data on the title column and see just the entries related to title A. Or create a pivot table of that data so I can see all sales for that title grouped together.

      If they haven’t, then I’m stuck deleting rows of information I don’t need to get to the data I want.

      Which is all a roundabout way of saying that you can input your data any way you want, but if you follow some key data principles you’ll have a lot more flexibility in what you can do with your data once it’s entered.

      Those principles are:

      
        
        1. Use the first row of your worksheet to label your data.

      

      

      
        
        2. List all of your data in continuous rows after that first row without including any subtotals or subheadings or anything that isn’t your data. Keep all data for a specific item on one row. (So a customer buys something from you on July 1st, have all of the information related to that transaction on one single line if transactions are what you care about. Or have all information related to sales of Widgets on one line per transaction if what you care about is your widgets.)
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